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Abstract This study is the work of identification of watershed characteristics by using Geographic Information
System (GIS) software, and Geoprocessing ArcGIS Model Builder program featuring Digital Elevation Model
(DEM) map of a specific region. DEM map of the province of Tekirdag was used the study area. At the end of
the study, visual programming language designed program Geoprocessing and Model Builder methods can
easily be applied to any conditions provided by DEM map.

In this study, the main watershed characteristics for the catchment area of the Central District of Tekirdag
ArcGIS Geoprocessing model is developed by subtracting. ArcHydro which is a model of ArcGIS has been used
to determine the model and basin. ArcGIS is a free software and it is used for hydrologic applications. This
model is developed for the Central District of Tekirdag is a digital elevation data, unrelated to the size of any
watershed characteristics of the basin, can be removed only by entering the DEM map data.
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1. Introduction

Today, as technology constantly developing, there are new methods and new systems emerging. These
developments are easier to correct the information needed and the results can be achieved quickly, further
information can be evaluated efficiently. Developments in science and technology, ushered in a new era of so-
called information age. Experienced in the sector of activity is carried out based on the position change and
development as a result of Geographic Information Systems (GIS) has emerged [1].

Becoming more complex pressures on water resources requires the use of technology in the production of
alternative solutions. "If you do not know you cannot run System" to determine the principles of the movement
basin water resources in the river basin management for some constitutes the first step towards recognition
system. In the first part of GIS data management performs an important component of time and space have been
studied to determine the catchment using ArcHydro. ArcHydro with time-dependent data that enables greater
ease of management including hydrologic time series data, it is possible to determine the movement of the water
on Earth in relation to spatial features [2].

2. Background

Arc Hydro is a geospatial and temporal data model for water resources that operates within ArcGIS. Arc Hydro
has an associated set of tools, built joint by ESRI and CRWR (Center for Research in Water Resources), that
populate the attributes of the features in the data framework, interconnect features in different data layers, and
support hydrologic analysis [3].

Researchers have proposed geographic data models for hydrology that address shortcomings in current GIS data
models to various degrees, but these data models are often specific for one hydrologic modeling system. Band et
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al. (2000), for example, express a set of hierarchical spatial objects for representing hydrologic structure and
dynamics (i.e. world, basin, hillslope, zone, patch, etc.) and provide a geographic foundation for the RHESSys
watershed model. Likewise, Wang et al. (2005) describe an object-oriented approach for representing and
stimulating a watershed system built from the TOPMODEL hydrologic model. Our approach is different in that
we propose classes that are specially designed to support interoperability between multiple modeling systems
[3].

Mervade (2012) has used Arc Hydro tools to process a DEM to delineate watershed, sub-watersheds, stream
network and some other watershed characteristics that collectively describe the drainage patterns of a basin. The
results from this exercise can be used to create input files for many hydrologic models. An exercise on how to
use these results to create a HEC-HMS model is provided as a follow-up to the exercise [4].

According to Jonathan and Maidment, ArcHydro is perhaps the best example of a spatiotemporal data model of
hydrology with the same objective of interoperability, but because ArcHydro is derived from ESRI ArcObject
classes, ArcHydro developers were required to create spatiotemporal objects through relationships between
feature classes & an object class that stores temporal information [5].

Researchers have identified suitable sites for water harvesting ponds using spatial multi-criteria analysis
(SMCA). In total, 12 spatial data- sets were used for this research, 14 criteria have been selected for defining a
proper sink, and each of these criteria is converted into the common scale differently based on whether one is a
constraint or a factor. At the end of the factor analysis, the proper sinks were divided into four classes, namely:
unsuitable, marginally, moderately and highly suitable. Ground truth observation was carried at randomly
selected 13 proper sinks. Overall accuracy of site selection for water harvesting ponds using SMCA was 92.3%.
Due to the very different natural zones and fluctuating climate of Mongolia, spatial factors for SMCA were
standardized instead of using interval divisions[6].

The utilizes hydraulically-calibrated aerial photography and GIS to were calculate cross- sectional and mean
stream power on a stretch of the Brazos River in central Texas. Field measured water depths are regressed
against image brightness values to establish a highly accurate depth to reflectance curve. GIS-derived water
surface slopes are then combined with estimated water depths to map fully two-dimensional hydraulic
processes. This type of image-based river monitoring provides both an advance in measurement accuracy and in
temporal monitoring [7].

With all GIS feature objects being reduced to a point or a PSLG (Planar Straight Line Graphs), a domain
decomposition tool like TRIANGLE can be used for unstructured mesh decomposition. However, the raw
polylines and the ones obtained from reprocessing of GIS polygons generally have segment lengths that are very
small compared to the dynamical scales of interest in the hydrologic model. The smaller segment lengths are an
artifact of DEM-processing based watershed delineation algorithms that are available in ArcHydro and
TauDEM tool. Segments obtained from DEM processing have their lengths determined by the resolution of the
DEM used for watershed delineation. Digitized watershed polygon boundaries may be composed of segments
with smaller lengths than are needed to efficiently represent process dynamics [8].

The delineation of small catchment areas is based on the HydroSHEDS drainage direction raster and was
implemented using the ArcHydro toolset for ArcGIS. The workflow to calculate catchment areas with ArcGIS is
depicted in Figure 2 and described in detail by Zhang et al. (2010) and Mervade (2012) [4]. Starting with flow
direction information, we computed the flow accumulation. This information was then used to define a stream
network. In this case study, grid cells are considered as drainage channels if 2000 or more upstream cells drain
into it. The drainage channels were exported as vector data. Finally, catchment areas were delineated using all
river junctions, calculated from the drainage channel vector file. This procedure ensures that all cells within the
same catchment drain into the same stream. As a result, we obtained 779 unique catchment polygons [9]

The study focus on land use land cover, drainage network, stream ordering and age of the streams in the
extended area of Bannerghatta National Park. The drainage network and micro watersheds are developed for the
study, using ArcGIS by manually the drainage network and micro watersheds delineated and for these micro
watersheds, bifurcation ratio was found using the Strahler method of stream order to find the age of the streams
and also the drainage network and micro watersheds are extracted using ArcHyro tools. In the study area, we
have tried to understand the land use and land cover by supervised classification using maximum likely hood
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classifier with the ENVI software [10].

3. Material and Methods
3.1. Description of the case study and data sets

Tekirdag - Suleymanpasa district is selected as the research area. Digital Elevation Model used in this study
(DTM) is a height map obtained from ASTER module in Terra satellite (Figure 1).

10 5 0 10 Kilometers

Figure 1: Unprocessed ASTER DEM data
3.2. Methodology
The initials of study are determined only by DEM river basins by using ArcGIS Desktop 10.0 software.
Tekirdag - Siileymanpasa district were utilized for this cut DEM map. ArcGIS Spatial Analysis Module with the
following stages of the software has been applied in the determination of the river basin in the county.
Performed stages are respectively; The direction of flow (Flow direction), Flow units (Flow accumulation),

raster calculator (Raster calculator), river flow regulation (stream order), flow from the vector (Stream to
feature) (Figure 2).

Flow direction > Spatial analisttool > Hydrology > Flow direction >

Flow ) > Spatial analist tool > Hydrology > Flow accumulation >
accumulation

Raster > Spatial analist tool > Map algebra > Raster calculator >
calculator

Stream order > Spatial analist tool > Hydrology > Stream order >
Stream to > Spatial analist tool > Hydrology > Stream to future >
future

Figure 2: Processing follow-up schedule
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After all these applications were made DEM in ArcHydro module in ArcGIS program (DEM reconditioning)
Fill in the blanks (fill sinks), Current aspects (flow direction), flow accumulation (flow accumulation), Rivers
identification (stream definition), River partitioning (stream segmentation ), the creation of the catchment area
(catchment grid delineation), the catchment area of the polygon GAME (catchment polygon processing),
processing of drainage lines (drainage line processing), determination of the watershed area (adjoins catchment
processing), processing drainage point (drainage point processing), determination of the catchment area
(watershed delineation batch), results have been achieved (Figure 3).

ArcHydro Tools > Terrain preprocessing> DEM reconditioning >

Fill sinks >

DEM >
Reconditioning

Fill Sinks ArcHydro Tools > Terrain preprccessing>

Flow Direction

ArcHydro Tools

> Terrain preprocessing>

Flow direction >

Flow
Accumulation

ArcHydro Tools

> Terrain preprocessing> Flow accumulation >

Stream Definition

ArcHydro Tools

> Terrain preprocessing>

Stream definition

Stream
Segmentation

ArcHydro Tools

> Terrain preprocessing> Stream segmentation

Catchment Grid

ArcHydro Tools

Catchment grid

> Terrain preprocessing>

Delineation delineation
Catchment

. . Catchment polygon
Polygon ArcHydro Tools Terrain preprocessmg> processing
Processing

Drainage Line Drainage line

ArcHydro Tools

> Terrain preprocessi ng>

Processing processing
Adjolnt ArcHydro Tools Terrain preprocessin Adjoint catchment
Catchment Y prep! g processing
Processing

Drainage point
processing

Drainage Point
Processing
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ArcHydro Tools

AVA VAR VERVE R VARV RS

> Terrain preprocessing>

Figure 3: ArcHydro module flow chart

With the usage of the AGREE method, DEM renewal function reorganizes rearrange the DEM. AGREE method
is a method that DEM superficial renovations to the data. The system adjusts the superficial elevation of the
SYM map so that it is consistent with the vector directions. In this part, vector directions mean "river flow nets".
Renovation the DEM, helps the adjustment of elevation values to vector data of river network. In the studies,
high accuracy of raster data means collecting more circuit data of water collection basins are so healthy. Last
step of the process is Model Builder ArcGIS’s visual programming tool. With this tool, whole work flow charts
will adapt step by step on the Model Builder screen with inputs and outputs of data will be controlled and
applied in one phase.

Watershed
preprocessing

Batch Watershed
Delineation

Batch watershed

ArcHydro Tools delineation

N\

4. Results and Discussion

As a result, for TekirdagSiileymanpasadistricted with usage of DEM map, collected data from Spatial Analysis
module of ArcGIS program which flow direction, flow accumulation, raster calculator, river regulation and the
flow to the vector data are given in Figure 4.
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Figure 4: a.) Flow accumulation map without using AGREE method, b.) Flow accumulation map with using
AGREE method, c.) The lower watershed and the surrounding polygons, d.) The lower watershed drainage line
and for each drain line connected to drainage points

After the findings, main objective of this research Model Builder application has been shown at figure 5 with the
help of Arctoolbox’s visual programming.

Figure 5. Visual programming of processes using the Model Builder
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The end result of the study shows that the parts up to the comment part of an application made with ArcGIS
program can be visually programmed with the part called model builder and it can come to the nearest place by
starting the process.

This has shown us that a visual programming tool located in the ArcToolbox ArcGIS each part model builder
can be programmed in a visual way and the same process can be applied in different DEM map with the
condition of the raw data to be changed accordingly. The created model can be saved, and carried to other
computers. This future is provided ArcGIS technology. The creating models makes it easy to use the
calculations on internet basic application such as ArcGIS Server. There is no need to know any programming
language to do this visual programming. Every person who knows ArcGIS can easily made the calculation. The
integration of the Model Builder makes calculations processwhich help us save more time. At Figure 6 given see
the final phase of DEM map, and at Figure 7 shows the selected sample basin area.

Lejand

®  Basin poimnt
20 10 0 20 Kilometers - Drainage lines
N T — - Watershed

Figure 6: DEM Map results

Lejand
© Basinpoint

e Drainage lines

E Watershed

Figure 7: Selected sample basin area

S
)

5
)

i

Journal of Scientific and Engineering Research

197



Albut S et al Journal of Scientific and Engineering Research, 2017, 4(6):192-198

Selected basin area’s numerical characteristics can be seen at Table 1.

Table 1: The numerical values attached Basin

Basin area 410.820,00 m?2

Basin environmental length 116.833,00 m

Distance of basin weight point to basin outlet 15.339,00 m

Basin weight point height 64,00 m

Basin outlet height 34,00 m

Longest river bed 40.491,00 m
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